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SUMMARY

Here, we present a protocol for electrotaxis of large epithelial cell sheets without
compromising the integrity of cell epithelia in a high-throughput customized
directed current electrotaxis chamber. We describe the fabrication and use of
polydimethylsiloxane stencils to control the size and shape of human keratino-
cyte cell sheets. We detail cell tracking, cell sheet contour assay, and particle im-
age velocimetry to reveal the spatial and temporal motility dynamics of cell
sheets. This approach is applicable to other collective cell migration studies.
For complete details on the use and execution of this protocol, please refer to
Zhang et al. (2022).1

BEFORE YOU BEGIN

Protocol overview

Cells migrate collectively duringwound healing, development, and regeneration in vivo. This kind of col-

lective migration is also found in monolayer wound healing assays, cell sheet migration of keratinocytes,

andMDCK cells in vitro. Cells in collectivemigration keep physical, chemical, and biological cell-cell con-

nections during migration, and behave differently compared with cells that migrate individually. A qual-

itative and quantitative understanding of the cell motility dynamic at spatial and temporal dimensions

under various conditions is critical in studying cell collective migration. Some very elegant studies

have demonstrated characteristics of collective cell migration in electric fields.2–4 We have studied col-

lective cell migration in organ culture and cell culture.1,5–8 Here, we describe our specific step-by-step

guide on how to direct and analyze a set of large epithelium cell sheetsmigrating in an electric field using

well-patternedhuman keratinocyte cell sheets as themodel. In principle, this protocol can be adapted for

cell collective migration under other treatments.

Fabrication of polydimethylsiloxane (PDMS) cell stencils and strips

Timing: 2 h

STAR Protocols 4, 102288, June 16, 2023 ª 2023 The Author(s).
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1. Fabricate PDMS stencils for cell patterning and strips for the electric field (EF) stimulation cham-

ber.

a. Precisely cut the PDMS pieces (200 mm in thickness) as designed (Figure 1) using a cut-through

mode of a computer-controlled CO2 laser cutter (VLS 2.30).

b. Gently remove the undesired debris (highlighted in white in Figure 1A) with tweezers.

c. Thoroughly clean PDMS stencils in a 95% ethanol ultrasonic bath for 5 min.

d. Air dry the PDMS stencils.

e. Store the PDMS stencils in a sterile petri dish.

f. Sterilize the PDMS stencils and strips with UV lights in the biosafety cabinet for 30 min right

before use.

Note: The size and shape of the patterning in the PDMS stencil can be adjusted at your desire.

In Figure 1A, the size of the small square, triangle, and circle presented are 1 mm2 and the size

of the larger square is 4 mm2. Square cell sheets ranging from 0.53 0.5 mm2 to 4.03 4.0 mm2

in size have been tested and proved feasible in this system. To form a firm attachment be-

tween PDMS and cell culture dish, the minimal distance between two cell sheets in the

PDMS stencil should be more than 2.0 mm, as it is illustrated in Figure 1A. At this distance,

the adjacent cell sheets will not migrate into others, or over the surface used to be occupied

by other cell sheets in a 12-h experiment, thus avoiding complicating factors such as interac-

tion with neighbor cell sheets. This distance can be adjusted depending on the purpose of ex-

periments, and whether the interaction of neighbor cell sheets is going to be investigated.

CRITICAL: To keep PDMS stencils clean and dry, they should be handled with clean twee-

zers throughout the experiment.

Fabrication of the EF stimulation chamber

Timing: 1 h

2. Fabricate the EF stimulation chamber.

a. Gently attach the sterilized PDMS strips in parallel to the 100 mm culture dish (Figure 2A). The

gap between PDMS strips should be �20 mm.

b. Add four high-vacuum silicone grease blockers to form the side walls of the EF stimulation

chamber (Figure 2A).

CRITICAL: Air bubbles should be avoided between PDMS strips and the cell culture dish to

make a firm attachment of PDMS stencils to the cell culture dish. The silicon grease blocker

together with PDMS strips should be sealed and waterproof and are supposed to build up

two isolated reservoirs (on the left and right side of the PDMS strip located in the center

of the chamber) in the electrotactic chamber. High-vacuum silicone grease is soft,

Figure 1. Design for PDMS Cell stencil and strips

(A and B) Top view of the cell stencil (A) and strips (B).

ll
OPEN ACCESS

2 STAR Protocols 4, 102288, June 16, 2023

Protocol



non-melting silicone designed for sealing and lubrication in vacuum and pressure applica-

tions. No elapsed time is required before proceeding to the next step.

KEY RESOURCES TABLE

Figure 2. Design of EF stimulation chamber

(A–H) Top view of the EF stimulation chamber in each stage. Green lines indicate the high-vacuum silicone grease. (D and H) are the photos of the

chamber in the stage (C and G).

REAGENT or RESOURCE SOURCE IDENTIFIER

Chemicals, peptides, and recombinant proteins

FNCCoatingMix� (a specially formulated reagent
that increases the attachment of cells to the plastic
substratumused for culturingmammalian cell lines,
According to the vendor, it is a specially formulated
mixture of fibronectin, collagen, and albumin.)

Athena Environmental Sciences Cat#0407

DMEM Gibco Cat#C11965500BT

FBS Gibco Cat#10099-141

Penicillin-streptomycin Gibco Cat#15140-122

Ca(NO3).4H2O Sigma Cat#C2786

MgSO4.7H2O Sigma Cat#63138

Tris Sigma Cat#10708976001

Agar Sigma Cat#A7002

Deposited data

MATLAB code for PIV This paper Mendeley Data: https://doi.org/10.17632/
d4ytd5n98f.1

Experimental models: Cell lines

HaCat Cell Lines Service CVCL_0038

Software and algorithms

MATLAB MathWorks MATLAB R2021b https://www.mathworks.com/
products/MATLAB.html

ImageJ/FIJI Schindelin et al.9 https://imagej.net/Fiji

MTrackJ Meijering et al.10 https://imagescience.org/meijering/software/
mtrackj/

COMSOL Multiphysics COMSOL Inc v5.0

(Continued on next page)
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Note:Depending on the hardware used, users may require alternative imaging software. FNC

coating mix is optional depending on the cell line you adopt.

MATERIALS AND EQUIPMENT

Continued

REAGENT or RESOURCE SOURCE IDENTIFIER

Metamorph NX Molecular Device MetaMorph NX 2.5, https://www.molecular.
devices.com/products/cellular-imagingsystems/
acquisition-and-analysissoftware/
metamorph-microscopy

MatPIV1.6.1 Sveen et al.11 https://www.duo.uio.no/handle/10852/10196

Other

Cover glass (50 3 24 mm2 ) Fisher Scientific Cat#12-548-5MP

PDMS pieces/Silicone rubber (200 mm in thickness) B&J Rubber Products N/A

high-vacuum silicone grease Dow Corning Cat#Z273554

Silver electrode Advent Research Materials Ltd Cat#AG549109

U-shaped glass tube Donghai Xinyou Quartz Products Ltd. N/A

True-RMS digital multimeter RadioShack Cat#2200087

Laser System Engraver’s Network VLS2.30,

Soldering Iron Kit (30 W) Marksman N/A

Zeiss Axiovert 200M Inverted Fluorescence
Microscope

Carl Zeiss N/A

XL Incubation for Inverted Research Microscopes Carl Zeiss N/A

DC power supply Beijing Liuyi Ltd. DYY-6C

Cell growth medium formulation

Reagent Final concentration Amount

DMEM 13 44.5 mL

FBS 13 5 mL

Penicillin-Streptomycin 13, 100 U/mL 0.5 mL

Total N/A 50 mL

Keep at 4�C for up to 3 months.

Steinberg’s solution (103)

Reagent Final concentration Amount

NaCl 580 mM 34 g

KCl 6.7 mM 0.5 g

Ca(NO3).4H2O 4.4 mM 1.0 g

MgSO4.7H2O 13 mM 3.13 g

Tris 46 mM 5.52 g

ddH2O N/A �1 L

Total N/A 1 L

Keep at room temperature (16�C–25�C) for up to 3 months.

Agar gel formulation

Reagent Final concentration Amount

Agar N/A 1.5 g

Steinberg’s solution (13) 13 100 mL

Total 1.5% wt/vol �100 mL

Dissolve it in a microwave, and keep it at room temperature (16�C–25�C) for up to 1 week.
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DC power supply

A direct current supply that is normally used in the lab for electrophoresis can be used in this exper-

iment. The voltage of the supply should range from 0 to 150 V.

U-shaped glass tube

The diameter of the glass tube should be in the range of 0.5 cm–0.8 cm. The length and shape of the

U-shape glass tube should be adjusted according to the height of the beakers you use. See

Figures 4A and 4B.

Lid of the EF stimulation chamber

Two holes are punched in the lid of a 100 mm cell culture dish with a heated soldering iron, as shown in

Figure 4B. The distance between the two holes is�50 cm. The diameter of the holes should be� 1 mm

larger than that of the U-shaped glass tubes. Oversized holes on the lid should be avoided to prevent

excessive evaporation of the cell culture medium during the long-term experiment.

Microscope

An inverted microscope (Carl Zeiss, Oberkochen, Germany) equipped with an XY motorized stage,

time-lapse imaging software (Metamorph NX; Molecular Device, Sunnyvale, USA), and a Carl Zeiss

incubation system was utilized. The microscope system was able to capture images of multiple

locations.

STEP-BY-STEP METHOD DETAILS

Plating cells for imaging

Timing: 18 h

Seeding of cells inside the EF stimulation chamber reservoirs and patterning of cell sheets in the de-

signed size and shape of the PDMS stencil.

1. Preparation for cell patterning.

a. Precoat the area between each strip with 0.5 mL FNC at room temperature for 5 min.

b. Remove the FNC coating mix with a pipette.

c. Wash the area with PBS one time.

d. Air-dry the coating area.

e. Gently attach the sterilized PDMS stencils between the strips in the cell culture dish (Fig-

ure 2B).

f. Add silicone grease around the PDMS stencils (Figure 2C) to make two reservoirs to store cell

suspension for cell patterning. Figure 2D is the photo of chamber at this stage.

Note: For each electrotaxis chamber, two PDMS stencils are applied, one for the electrical

stimulation group and the other for the control (without electrical stimulation).

CRITICAL: Air bubbles should be avoided between the PDMS and the cell culture dish to

make a firm attachment of the PDMS stencils to the cell culture dish. The device’s reser-

voirs are designed to be sealed and leak-proof.

2. Seeding cells for cell patterning (Figure 3).

a. Prepare a cell suspension at a concentration of 83106 cells/mL.

b. Add 1 mL of cell suspension for each cell patterning reservoir.

c. Gently move the dish to an incubator and allow cells to attach for 15 min.

d. Observe the cells with a microscope to ensure the desired cell density (troubleshooting 1).

e. Gently remove the medium containing any unattached cells with a pipette.

f. Add fresh cell culture medium and incubate cells overnight (�16 h).

ll
OPEN ACCESS

STAR Protocols 4, 102288, June 16, 2023 5

Protocol



g. Observe the pattern of cell sheets with a microscope and confirm whether a confluent mono-

layer is formed.

h. Using a pipette, remove the cell culture medium from the reservoirs.

i. Gently peel off the stencil with tweezers.

j. Gently wash the patterned cell sheet with the culture medium.

k. Using a microscope, examine the pattern of the cell sheets and confirm that they are in the

desired size and shape (troubleshooting 2) (Figure 2E).

CRITICAL: For the HaCat cells, we recommend to keep the passage number lower than 30.

Move the dish gently to avoid disturbing the settlement and adhesion of cells after seed-

ing. The time required for cell attachment is cell type-dependent. When peeling off the

stencil, try to peel it off from corners with tweezers and avoid contact with grease. In

case the tweezers are contaminated by the grease, clean the tweezers with 75% ethanol

and tissue paper. PDMS stencils will remain intact after peeling off. Discard the used

PDMS stencils.

Assembling the EF stimulation system

Timing: 1 h

This section describes the assembly of the EF stimulation chamber, preparation of salt bridge and

set up the electrotaxis system.

3. Assembling the EF stimulation chamber

a. Add 0.5 mL cell culture medium in the area between PDMS strips.

b. Gently put cover glasses over the stimulation area of the chamber (Figures 2E and 2F).

c. Seal the stimulation chamber into two reservoirs (on the left and right) by placing silicone

grease on the top of the cover glasses (Figures 2F–2G). Figure 2H is the photo of the chamber

at this stage.

d. Add 6 mL fresh cell culture medium in each reservoir.

Note: Since the distance between PDMS strips is less than 20 mm, thus the cover glass (50 3

24 mm) can be laid on the PDMS strips. In Figure 2G, areas a and b, g and d are connected by

the intervals between the cell culture dish and cover glasses, respectively.

CRITICAL: Air bubbles should be avoided between the cover glass and the cell culture

dish. The device’s reservoirs are designed to be sealed and leak-proof. Make sure the me-

dium can go through the space between the cell culture dish and the cover glass. To store

6 mL of cell culture medium in each reservoir, we have to build up walls of the reservoir

with silicon grease, as shown in the Figure 2G.

Figure 3. Cell patterning workflow

Reproduced with permission from iScience.1
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4. Preparation of salt bridge.

a. Melt the 1.5% agar in 13 Steinberg solution by microwave.

b. Slowly fill the agar in the glass bridge.

c. Leave the salt bridge at room temperature to solidify.

CRITICAL: The agar solution should be fully melted before filling the glass bridge. Air bub-

bles should be avoided in the glass bridge.

5. Set up the electrotaxis system.

a. Preheat the incubator of the living cell imaging system (37�C, 5% CO2).

b. Move the electrotaxis chamber into the incubator of the living cell imaging system.

c. Full-fill two beakers (100 mL) with 13 Steinberg’s solution (Figures 4A and 4B).

d. Connect the electrotaxis system including the power supply, electrodes, salt bridges, beakers

with saline, electrotaxis chamber, and wires (Figures 4A and 4B).

e. Switch on the DC power supply.

f. Monitor the voltage by inserting electrodes of a multimeter at the two ends of the coverslip in

the EF stimulation chamber, as indicated in Figure 4A.

g. Adjust the total voltage of the current supply to achieve the desired voltage between the two

ends of the cover glass.

h. Switch off the DC power supply.

i. Cover the cell culture dish with a sterilized lid with holes in it.

j. Align the electrotaxis chamber with the motorized loading stage of the microscope and make

sure that the applied electric field is parallel to one edge of the stage.

k. Note the relative position of the cathode and anode in the electrotaxis system.

Note: For our experiment, the length of the cover glass is 50 mm, and to obtain an electric

field of 200 mV/mm, the voltage measured should be 10.0 V.

CRITICAL: Wear insulating gloves and take caution against electric shock. The desired

voltage between the two ends of the cover glass depends on the targeted strength of

electric fields and the size of the cover glass. Electric fields distribute uniformly in the

EF stimulation area, as indicated in Figure 4C, and cell sheets should be patterned in

this field. Note the relative position of the electrodes.

Monitoring collective cell migration using time-lapse microscopy during EF stimulation

Timing: 9 h

Figure 4. Electrotaxis system setup

(A and B) electrotaxis experiment setup.

(C) Electric potential and current density of the electrotaxis chamber simulated by COMOSL Multiphysics. Scale bar = 1 cm. Reproduced with

permission from iScience.1
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This section describes a step-by-step walkthrough of live cell imaging of collective cell migration in a

large cell sheet.

6. Preparation for imaging.

a. Start the image acquisition software and set up the parameters required for the time-lapse.

b. Select the objective according to the experimental demand. Here we use a 103 phase

contrast objectives lens for imaging.

c. Bring the imaging window of the stimulation chamber into focus.

d. Navigate to a well-patterned cell sheet.

e. Navigate an XY position to find a corner of the cell sheet and save the position in the image

acquisition system.

f. Navigate a series of XY positions to cover the whole cell sheet and make sure each adjacent

region of interest (ROI) has a 20% overlap along the x and y axes.

g. Navigate to the other cell sheets in the chamber and save the position in the imaging acqui-

sition system. Cell sheets from both the EF-stimulation group and the NO EF group can be

acquired in order.

h. Give it a dry run by clicking the acquisition button.

i. Stop image recording after finishing the first frame of all ROIs.

j. Check the quality of the images to confirm that the focus and exposure of the image are set

correctly and that there is no shift during multi-position acquisition.

Note: In this study, the time interval was set as 5 min. The duration was set as 7 h. In our setup,

9 ROI with 20% overlap are required for a square cell sheet up to 1 mm 3 1 mm in size.

CRITICAL: Cell sheets keep expanding after we peel off the PDMS stencil, thus to have a

well-controlled experiment, the time spent on setting up the electrotaxis system and

setting path of the imaging should be controlled within a certain time (in our experiment,

it is about 1 h), thus making each independent round of experiments comparable.

7. Perform real-time imaging with precisely controlled EF stimulation.

a. Start multi-position time-lapse recording by clicking the acquisition button again.

b. Switch on the DC power supply at the desired time.

c. Monitor the voltage during stimulation and adjust it if needed.

d. Check that all stage positions are still in focus at later points.

e. Stop image acquisition at a defined time point.

f. Switch off the computer and microscope system.

Note: In our study, EF is applied 1 h later after the time-lapse recording, and the EF stimula-

tion duration is 6 h.

CRITICAL: Stage drift is a common complication when performing time-lapse recordings

that span multiple hours. If images need to be refocused, pause imaging recording at an

appropriate time point (at the end of the last round acquisition), adjust the focus and

resume imaging within a few seconds, up to a couple of minutes. EF stimulation will not

need to be stopped while adjusting the focus.

8. Generation of time-lapse movies of integrated cell sheets using ImageJ software.

a. Launch the ImageJ program and import the imaging file using ‘‘File>Import>Image

sequence’’.

b. Adjust the brightness and/or contrast to attain a better view of the images by clicking

‘‘Image>Adjust>Brightness/Contrast’’.

c. Images are then stitched together using Grid/Collection Stitching plugin in the ImageJ.
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d. Slight shifts of the images in the video are corrected by using Registration-Register Virtual

Stack plugin in ImageJ software by clicking ’’Plugins>Registration>Register Virtual Stack’’.

e. Save the video as single ‘‘.tiff’’ files (troubleshooting 3) (Figure 5).

CRITICAL: Video must be saved as an image sequence in the form of TIF to meet the

requirement of further analysis in ImageJ and MATLAB.

EXPECTED OUTCOMES

At the end of the protocol, the stitched time-lapse video will form a full image of the well-patterned

cell sheet (Figure 5) which can be used to visualize the response of collective cell migration to an

electric field. Results from the individual cell tracking in the different regions of the cell sheet can

reveal the region-dependent directionality and speed dynamics of collective cell migration of the

cell sheet (Figure 8) on the scale of individual cells. Individual cell tracking is limited in throughput,

and thus the PIV analysis complements the tracking by allowing the measurement of motility dy-

namics across entire cell sheets (Figures 9 and 10).

QUANTIFICATION AND STATISTICAL ANALYSIS

Timing: 3 h

This section describes a step-by-step walkthrough of the collective cell migration assay with ImageJ

and custom-made MATLAB code based on MatPIV1.6.1.11

1. Cell migration trajectory analysis with ImageJ.

a. Launch the ImageJ program and import the imaging file using File>Open.

b. Set the scale of the image by using’’ Analyze>Set Scale’’. In our study, the scale is 0.61

pixels /mm.

c. Individual cells were tracked using ImageJ’s MTrackJ plugin (Plugins>MTrackJ > Add).10

d. To analyze region-dependent cell migration in the cell sheet, we define cells in the leading re-

gion, rear region, and lateral region (right) as the 10 rows of cells away from the free edge (Fig-

ures 6 and 8A).

e. Measure cell migration trajectories by clicking ‘‘measure’’ in the toolbox of the MTrackJ.

f. By clicking ‘‘save’’ in the toolbox of the MTrackJ, export the coordinates of each cell at each

time point from ImageJ.

g. Use the directionality to quantify the directedness of cell migration, which is defined as the

cosine of the angle between the cell motion and the y-axis (qi) (Equation 1) (Figure 7);

Cell migration speed is defined as the accumulated migration distance (Di) divided by the total time

(Equation 2) (Figures 7 and 8D).

Figure 5. Engineering of the cell sheets

(A and B) Cell sheets of defined size and shape were engineered using a PDMS stencil. Scale bar = 500 mm. Reproduced with permission from iScience.1
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Note: In this study, the position of a cell is defined by its nucleus. For each region, 20 uncon-

nected cells are tracked at 10-min frame intervals. In our experiment, the electrical field was

applied along the y-axis, and directed down the image (cathode at the top and anode at

the bottom). A cell migrating directly toward the anode would have cosine = 1 and sine =

0 (Equation 1) (Figures 7, 8B, 8C, 8E, and 8F).

Directionality =
1

n

Xn

i = 1

cos qi Equation 1

Speed =
1

n

Xn

i = 1

Di

duration
Equation 2

2. Cell collective cell migration analysis with PIV in MATLAB (Methods video S1).

a. Download the ‘‘PIV’’ folder from the Mendeley Data repository and save the folder on your

desktop.

b. Install MATLAB 2016.

c. Set the ‘‘PIV’’ folder as the current folder in MATLAB.

d. Open the file PIV_batch_script.m in MATLAB.

e. Change the directories listed at the top of the script. For example, to run the code on the test

images, use directories = {’C:\Users\...\Desktop\PIV\test\’}.

f. Run the PIV_batch.m script file by clicking ‘‘EDITOR> Run’’.

g. Find the newly generated files in the directories set in step f: 200 mvdot_piv.mat and

200mvdot_piv_filtered.mat. For further analysis, we will use 200mvdot_piv_filtered.mat.

h. Generate the migration speed heatmaps of the cell sheet (Figures 9A and 9B).

i. Load 200mvdot_piv_filtered.mat into the workspace.

ii. Input plot_piv_pcolor_speed (dot_piv) in the command window in MATLAB and click Enter

on the keyboard.

iii. Find the newly generated files in the image folder under a subfolder with the image name,

e.g., 200 mv. This folder includes a set of speed heat maps of the cell sheet.

iv. You can open and edit the figures in the format of .fig with MATLAB.

i. Generate the directionality heatmaps of the cell sheet (Figures 9A and 9B).

i. Load 200mvdot_piv_filtered.mat into the workspace.

ii. Input plot_piv_pcolor_sin (dot_piv) in the command window in MATLAB and click Enter on

the keyboard.

iii. Find the newly generated files in the image folder under a subfolder with the image name,

e.g., 200 mv. This folder includes a set of directionality heat maps of the cell sheet.

j. Generation of kymographs (Figures 9C and 9D) and rose plot.

Figure 6. Illustration of selection of cells at the right

region of the cell sheet for cell migration trajectory

analysis

Cells in the cell sheet are not arranged strictly in rows,

we can only roughly count the rows. Scale bar: 50 mm.
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i. Open the piv_custom _analystics.m script in MATLAB.

ii. Change the directories to the location of the image folder, e.g., directories =

{’C:\Users\...\Desktop\PIV\test\’}.

iii. Run piv_custom _analystics.m by clicking ‘‘EDITOR> Run’’.

iv. Find the newly generated files in the image under a subfolder, Analytics Data. This folder

includes the directionality kymograph, speed kymograph, and rose plot for the cell sheet

collective migration. You can open and edit the figures in the format of .fig with MATLAB.

k. Generate the contour dynamics of the cell sheet (Figure 10).

i. Open outline_batch_script.m.

ii. Change the directories to the location of the image, e.g., directories = {’C:\Users\...\Desk-

top\PIV\test\’}.

iii. Find the newly generated files in the image folder under a subfolder for outline images

combined with the image name, e.g., Outlinelmages_200mv. This folder includes a set

of images of the cell sheet outline.

CRITICAL: Operators are assumed to be familiar with MATLAB and coding. For a quick

test of these codes, don’t change the name of any document and test the code on the pro-

vided test tif. The computer operating system we used is Windows 10. We used MATLAB

R2016a, and the code has also been tested in MATLAB 2021b and MATLAB 2022b. After a

successful test, you can change the parameters in the codes and run it for your experiment.

If you save all the videos generated in one experiment (with the same resolution, duration,

etc.) in one folder, PIV_batch.m, piv_custom _analystics.m, and outline_batch_script.m

will analyze all the images in that folder sequentially. A step-by-step operating video of

cell collective cell migration analysis with PIV in MATLAB was recorded, see Methods

video S1.

Note:Note that these files are named with the prefix 200mv as this is the name of the provided

test tif file. The diagnostic window size in PIV is 64 3 64 pixels, the secondary window size is

32 3 32 pixels, and there is a 50% overlap of adjacent windows; the interval of each image is

set by the imaging parameters (in this case, 5 min). The distinction between cellular and cell-

free areas is made by detecting changes in grayscale intensity using a Sobel filter, and the

program automatically removes the unnecessary signal in the cell-free area. The contour

and geometric center of the cell clusters are calculated by MATLAB’s built-in programs.

The edge effect in the PIV analysis is minimized by removing 8 pixels from the edges of the

cell area. u stands for the velocity in the horizontal direction and v stands for the velocity in

the vertical direction. For each 16 3 16 pixel window, PIV calculates a v and u for each time

interval. Cell migration speed was calculated as Speed =
ffiffiffiffiffiffiffiffiffiffiffiffiffiffiffi
u2 + v2

p
. Directionality was calcu-

lated as cos q = u/
ffiffiffiffiffiffiffiffiffiffiffiffiffiffiffi
u2 + v2

p
. The formulas for calculating speed and directionality here in

MATLAB are different from that in ImageJ, because the parameters generated by ImageJ

Figure 7. Schematic illustration of analysis of cell migration
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and MATLAB are distinct. However, the principles of the quantification are the same, and, if

desired, the PIV equations could also be applied to the ImageJ tracking data. The u, v, speed,

and directionality can be color-coded to indicate their corresponding values and projected on

the corresponding positions of the heatmap.

Kymographs are used to quantify and visualize the spatiotemporal dynamics of directionality and

speed from the PIV measurements. For each data matrix from the PIV analysis, we computed the

average value for each column or row parallel to the edge and then derived a one-dimensional

segment for each time point.

The contour of the cell sheets was segmented by custom MATLAB code that uses Sobel filtering to

find edges in the images. Small, segmented regions such as those from individual scattered cells are

excluded. The centroid of the cell sheet was computed using MATLAB’s regionprops function.

Figure 8. Leading cells lead collective electrotaxis with suppressed migration sideways

(A) Snapshot of regions of a cell sheet 1 h before the onset of EF and 6 h in the EFs. Scale bar: 100 mm.

(B–D) Cells in the leading (L), Central (C), and Rear (R) regions were tracked, for Y-axis displacement (B), directionality

(C), and speed (D) as a function of time during EF application. Data are presented as mean +/� SEM from 20 cell

migration trajectories from three independent experiments.

(E and F) Migration trajectories of cells in the leading region, central region, right region, and rear region of the cell

sheet in an EF and NO EF group. Data are representative of three independent experiments (n = 20 for each group).

EF = 200 mV/mm. Reproduced with permission from iScience.1
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LIMITATIONS

The electrotaxis system setup and preparation for imaging need a considerable period (�1 h) and as a

result, the response of the cell sheet right after peeling off the PDMS stencil can’t be recorded in our sys-

tem. Long-term active electrochemical reactions between silver electrodes and Steinberg’s solution can

result ina significant resistancevariationof the systemandpHchange in thecell culturemediumandStein-

berg’s solution. Thus this system is not designed for long-termobservation of EF stimulation beyond12h.

TROUBLESHOOTING

Problem 1

There are air bubbles at the corner of the area where you desired to pattern cells and this results in

incomplete patterned cell sheets. This issue is more frequent when your desired cell patterns are

very small. Related to step 2.

Potential solution

The following steps can be used to avoid air bubbles before cell plating.

� Add 0.5 mL of 75% alcohol to the cell patterning reservoirs before adding the cell suspension.

� Observe the cell patterning reservoirs in the microscope and there are no air bubbles in the cor-

ners of the desired pattern areas.

� Remove the remaining alcohol by rinsing the patterning reservoirs with 1 mL of cell culture me-

dium 10 times.

� Add cell suspension and continue the experiment.

Figure 9. EFs, overriding default directional cues at the free edge, guide and mobilize cell sheets by inducing the

propagation of increased directionality and speed across the whole cell sheet

(A and B) Snapshots of directionality (Dir) and speed heatmaps of a cell sheet in the first hour after EF application.

Directionality and speed of movement of the cell sheet are shown as heatmaps from PIV analysis from two adjacent

images with a time interval of 5 min. Scale bar = 500 mm.

(C and D) Kymographs of directionality and speed as a function of time along the x-axis (C) and y-axis (D), respectively.

Kymographs in the no EF group show that directionality and speed propagate from the free edge to the center of the

cell sheet and then deflect back when they meet. Kymographs in an EF (200 mV/mm) show a dramatic increase in

directionality and speed propagating from the leading edge to the rear edge. Dashed lines indicate the onset of the

field. The experiment duration is 7 h. The kymographs presented are drawn from one experiment and confirmed in

three independent experiments. Reproduced with permission from iScience.1
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Problem 2

Cell sheets are damaged and incomplete after the peeling of the PDMS stencil. Related to step 2.

Potential solution

Shorten the co-culture time of cells and the PDMS stencil. Peel off the PDMS stencil right after cells

form a confluent cell monolayer.

Problem 3

The edges of the cell sheet don’t migrate forward after peeling off the PDMS stencil. Related to

step 3.

Potential solution

Make sure that you have precoated the cell culture dish with the FNC coating mix and that the PDMS

stencil you used doesn’t leave any smears or tracks on the cell culture dish after being peeled off.

Figure 10. EFs induce collective electrotaxis of large epithelial sheets that maintain cell-cell junctions

(A) Phase contrast image of a square cell sheet. Scale bar = 500 mm.

(B and C) Collective electrotaxis is demonstrated by a contour assay showing the color-coded edge positions of cell sheets. Color coding from blue (0 h)

to yellow (6 h). Arrows indicate overall edge migration direction and distance. An EF guided directional migration of the cell sheet downward (C),

whereas a control cell sheet without EF expanded in all directions (B). The polarity and strength of the field are as shown.

(D–G) Collective electrotaxis of whole cell sheets is shown by the trajectories of the geometric center (centroid) of cell sheets (n = 6) (D and E). Y-axis

displacement (F), directionality along the field line (G), as a function of time. Directionality is calculated as cosq, where q is the angle between each

centroid trajectory and the electric field line. Data are represented as mean +/- SEM from 6 independent experiments. A positive value of cosq indicates

migration to the anode; a negative value indicates migration to the cathode, and zero indicates a random direction.

(H–K) EFs maintained cell sheet geometry by suppressing the dispersal of cells. Quantification of area increase (H–I), y axis expansion (J), and x axis

expansion (K). (**p < 0.01).

Data are represented as mean +/� SEM from 6 independent experiments. Reproduced with permission from iScience.1
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RESOURCE AVAILABILITY

Lead contact

Further information and requests for resources and reagents should be directed to and will be ful-

filled by the lead contact, Dr. Min Zhao (minzhao@ucdavis.edu).

Materials availability

This study did not generate new unique reagents.

Data and code availability

The dataset and code used during this study are deposited at Mendeley Data and are publicly avail-

able as of the date of publication. The DOI is listed in the key resources table. A previously published

article1 includes all the datasets analyzed in this study.

SUPPLEMENTAL INFORMATION

Supplemental information can be found online at https://doi.org/10.1016/j.xpro.2023.102288.
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